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The Cover Sheet - MS Word

You can create the Cover Sheet for your book using Microsoft Word.

The Cover Sheet

The Cover Sheet consists of four main components:

e The Back Cover
e The Front Cover
e The Spine
e Bleed Line

The Cover Sheet is printed as a singled-sided document on a sheet of 11 inch by 17 inch paper that is
wrapped around the pages of your book (Book Block).It is important to have all edits and the Book Block
completed in order to design your cover.

Calculate Spine Size

Before opening up Word we will need to calculate the spine width your book requires. This will be
determined by the thickness of your book block page count. Then we will align the back cover, spine,
and front cover. The Cover Sheet must wrap around the Book Block, so calculating the width of the spine
is a critical first step.

Calculate the width of the spine for your Book Block using the formula: ?
Page Count of Book Block + Pages Per Inch (ppi) = Spine Width

Premium white paper for Book Block: 377 pages per inch

Standard cream paper for Book Block: 434 pages per inch

Example: e e
Book Block: 100 pages

Printed on Premium white paper: 377 ppi

i Do not round up or down. i
| Use 3 decimal places. |

100 + 377 ppi = 0.265 inches for spine width

Minimum Spine Width for Text on Spine:
Book Block: 100 pages premium white paper
115 pages standard cream paper

Spine Width:  0.26 inches
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Calculate Overall Cover Dimensions

We will now use the spine width we calculated above to determine the overall dimensions for the Cover
Sheet. We will use these calculations to set up a custom page size.

Example: 6 inch by 9 inch book with .25 inch bleed

/ Bleed Line

Back Spine Front
Cover Cover
Width = + Front Cover Width + Spine Width + Back Cover Width +
Width = +6+.26+6+.
Width = 12.76 inches
Height = + Book Height +

Height = .25+ 9 +

Height = 9.5 inches

Example Cover Sheet Dimensions: 12.76 inches wide X 9.5 inches high

Width = .25 + + + +.25
Bleed Back Spine Front Bleed
Left Cover Cover Right
Height = .25 + + .25
Bleed Book Bleed
Top Height Bottom
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Open Microsoft Word

Now open Microsoft Word. First you are going to set up the Cover Sheet margins and paper size.

Adjust Margins
First set the margins to ZERO.

FILE HOME INSERT DESIGM PAGE LAYOUT REF
W — "# Breaks = Indent
Select Page Layout Tab @ rli_'ﬁ ID

: S _ f[ILine Numbers~ 3= Left |0’
Margins Orientation  5ize Columns -
- - - - bt Hyphenation =% Right: |0’

Page Setup @

Click Page Setup

Margins Tab of Page Setup \fage ety
. | [ wgen [ eaper [ epsut | |
Top: 0 Mg
Toe L} gotlan 0 1-
Left: 0 / q Bent o ; >
Guttes [} q Lett 157
-~ Orlertation
Bottom: 0
A &
nght 0 Portrant  Landjoase
_ Pager
Wultpie zager Marmeal ‘_—'J

Predew

I
Appiglae  Whale dooement =4
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Set Paper Size

Paper Tab of Page Setup Sage setp Vo
| | Magns | Paper lapout
Width = Calculated Cover Sheet Width Pape e
Height = Calculated Cover Sheet Height
Bt pape Qihes pages

DeCacst tra ranc =l
Autonaticady Sewect

AARTIRET Lacatt
AAerateally Sefect

Frnter oty pelect S31 | Ponter auto yelect s
Marmal Feed Marn Feed
Tray L Ty )
Tray 3 Ty 2
Unipecttied Unipecfegs
M Puwin
HP Matte 339 = | |HP Matte S0g -
Freean
Appiytoe | Whott dotument | w ) Bt Oghani.
Set AL Refaut ! o | Cancer
| Micrasoft Word -
|

Click Ignore

!‘\ One or more margins are set outside the pontable area of the page. Choose the Fix button to increase the appropriate margint.

Show Melp »»

m

Up Next: Inserting Spine Text
In order to print a title on the spine of the book, the spine must be at least .26 inches wide.
If your book is less than .26 inches thick, your spine will be too narrow for text. Leave it blank.

Common information included on the spine includes:

Title

Author’s Name

Series Name

Volume / Series Number

O 0 O ©
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Inserting Spine Title
You will next insert a text box and in the text box, add the information you want to appear on the spine.

Finally you will size the text box, rotate it, and align it to the center of the page.

Adding Text Box
Select the Insert Tab.

Then click on Text Box = Simple Text Box

over Page [e— SmartAnt y o i My periek Vamnaer - Juick Parts »
G » @ st W i 3
Blark Page A pl Chant ™ Bockmak Footes * NocdArt
7 bie  Picht Onire Shape ine C

"= Page Bresk Picturss Be Stiwermhiot Video =] Crony-refurence

Type in the spine text you desire into the | My TITLE BY AUTHOR SERIES NAME vol. 3

text box.

Click on the text box.

Select Drawing Tools Format tab

Change the height of the text box to match the width of your spine.

You may need to adjust the font size.

Check the width of your text box: The width must be less than the book height.
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Rotating Text Box
You will need to rotate the text box so the text will be properly oriented down the spine.

P

Click on the MY TITLE BY AUTHOR SERIES NAME vol. 3

border of the
text box.

Click on the rotation handle.

Use the rotation handle to turn the text box 90 degrees.

HOHLNY A9 F1LIL AN

Align Text Box to Center
Now you must place the text box in the very center of the Cover Sheet.

Select the Drawing Tools Format tab.

Click on the Align tool.

Select Align Center.

This places the text box in the center.

You may need to also select Align Middle
or adjust the placement from top to
bottom using the arrow keys on the
keyboard.
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Remove Text Box Borders

You do not want the black border around your spine text to print. We will need to select No Borders for

this textbox.
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Click on the text box. E
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Documentl - Word

WGE LAYOUT REFEREMCES MAILIMGS REVIEW
Select the Drawing Tools S— 2 Shape Fill -
Format tab. 3 | abc || Abe | [ L Shape Outiine -

. : L? Shape Effects -
ShapgStyles [P

Click on the Shape Outline tool. R

| [ thage xrtre - A
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Standerd Lobans

am “EEmREe
Verest Colors

L

/ Ne 0o
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Select No Outline

= len

Documentl - Word

T REFERENCES MAILINGS REVIEW

A

Select Shape Fill 29 Shape Fill -
| Abc ‘ - | L Shape Outline -
7| ¥ Shape Effects =

Shape Styles ]

C
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Select No Fill
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Front Cover Text

Next you will add text boxes for the front cover title.

Information commonly included on the front cover includes:

Title

Author’s name

Graphics / Images

Series / Edition / Version number

The Front Cover is to the RIGHT of the spine.

Place the text box where you want the title and
other information to appear.

Remove the text box border (page 7).

Remove the text box fill (page 7).

Back Cover Text

Information normally included on the back cover

About the Authar

includes:

Author Picture

About the Author

Praise / Review Quotes

Series: list of other titles in the series
Summary / Synopsis

Bullet List of Included Content

Insert back cover text to the LEFT of the spine.

Remember to remove text box outline and fill.
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Adding Images

You may only use images that you have created or have documented permission to use.
For the best results, you will want to use images that are:

e 300dpi
e Special picture effects selected in Word may not carry over to the PDF/A when saved.

Always avoid placing images onto the cover by drag and drop or cut and paste.

Insert Image Tool
To place an image onto a cover, you will want to use the Picture tool on the Insert tab.

B H S 0 =

FILE HOME DESIGM PAGE LAYOUT REF

B Cover Page~ rll_':] T SmartArt

Select Insert Tab [ Elank Page : 11 Chart
L Anline Shapes
| . -
. . reak - Pictures ~ a4 Screenshot
CIICk on Pictures Pages Tables Tllustrations
L 1
Navigate to the location you saved the : Z
) Pictures library , b s
icture. % S Arrange by: Folder
p Sample Pictures
( ) p
Select the image. (\\
|f}' 23 :-.
baseball_image, Chrysanthemum. Desert.jpg
ipg

Click Insert

Hydrangeas.jpg

Jellyfish.jpg Keala.jpg

[ |

Picturel jpg v (AII Pictures (*.emf;*.wmf;* jpg;’ v]

Tools Insert Iv] ’ Cancel ]
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Aligning Pictures

There are a few tools you can use to help place the picture in the perfect spot:

o Wrap Text

e Drag Into Position
e Bring Forward

e Send Backward

FICTURE TOOLS

Click on the image. Ew DEVELOPER FORMAT

Select the Picture Tools — L# Picture Border ~ .1 Bring Forward & Align =
Format tab. natil - | @ Picture Effects - — O Send Backward/ - Group
Paosition

rap

L Picture Layout = Text ~ Dl Selection Pane "k Rotate -

Iy Arrange

Wrap Text: select option that best meets your needs.
Bring Forward: Allows you to cover another element (text box, image, etc) with the selected image.

Send Backward: Allows the image to go behind another element.

Background Color
You can add a background color to all three parts of the Cover Sheet: font cover, back cover, and spine.

A
Insert Tab = Text Box

Text
Box~
illo4az 2
Click on Text Box and Format tab to size the text box to match the Cover Sheet. o

Select the fill color of your choice. | 22 Shape Fill =

Avoid: Page Color option in Design Tab

Avoid: Page Color tool. —== e T i Watzmalt Page Fege
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Adding Background Image
Use the custom watermark to add a background image that fills the entire Cover Sheet (Back Cover,
Spine, and Front Cover).

S I t th D . t b PAGT LAYOLT RIFEAENCIS
ign tab. - -
elect the Design ta - S - n ]ﬂ 7] PP T o & M

Click on the Watermark tool. A VSN R g’ < P o

Page Badhground

Select Custom Watermark

L memiren

Select Picture Watermark

/ Scale: :’-\Ixto :IZI V| Washout
() Text watermark
tes)

Language: ‘English {United

Click on Select Picture

K3 | KB | £

]

Navigate to the image, select, and click insert.

Automatic |~ ] | Semitransparent

Layout: @) Diagonal Haorizontal

App ‘ OX Cancel

Note: For more vibrant color uncheck washout.

The image on screen in Word will still appear washed out. When saved as a PDF/A the color will be
vibrant.
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Distance from Margins

This cover design includes a .25 inch bleed. This means anything any within .25 inches from the edge will
likely be trimmed off by the book machine. Having the artwork and colors extend to the bleed line helps
ensure that the finished trimmed cover will be in color to very edge and not include any white tips or
strips of white along the edges after the trimming.

Recommendation: Keep all text and essential design elements at least 0.5 inches from the borders of a
Cover Sheet designed using the method outlined here for Microsoft Word.

Save as PDF

Once all of your edits and changes have been made, it is time to save this working file as a PDF. To
preserve the rotated text and other options, we must first save as a standard high quality printing PDF.
We will be converting this later to a special PDF file type.

From the File menu:
Select Save As

Select location to save this PDF & e

Click on Options button ——— =~

In the Publish Options window:

Check PDF/A option should be UNCHECKED Coeates 3 arge il aptomices ov 0eskton oe coay 3hap ITBNG

Click OK I etam
| gner pcture retabation Kpd yiesds Detter prnt gualty with &
Il e nie sae
Click Save Color and greyeale picsrer
Downsanglete: 00dp v | whensbowe 40 dp: e
|| Derign Onecter

‘ :_'!IH\ MOt trnsparency and (oM e
‘ INCIage Nan. peatting inf comanan
(continued on next page) .
4 Dotugent struchure 1ags for accessitiny
R POF Cp
D50 13005.1 comphiant $OF 4
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9. Saving Image Quality
Microsoft Word will compress images put into a document. This compression will lower the image
quality and can have negative impact on the quality. To change go to:

File menu

Cowes_Shest | natracnans-Word docs

Home et Dewgn Lmpout Aeterences NMadkng: Henew Yiew Help Acrobat

CoiteiBody) ~/11 ~A A (Ao A g[A] IZT-i=-%- SE A Bl T | lamoccn! assbtde AZBHC: As8b

g Bl U-bxy R-7-A-AD &

« e 0o - T Narmal | No Sgecing
3 Forret Purnn

Clgboand ™ Fant 15 Varag s N

select Options.

Account

Feedback

Options

select Advanced

scroll to Image Size and Quality

Check Do not compress image files

Set default resolution to 330ppi or high fidelity

Word Options

General
Image Size and Quality
Display
. Discard editing data U
Proofing
Do not compress images in filel

Save . =

Default resolution: (0 | 330 ppi
Typography
Language Chart M
Ease of Access v| Properties follow chart data point

——»  Advanced

Show document content

Customize Rihbhon
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Convert to PDF to PDF/A

Next we need to convert the PDF to a PDF/A. The PDF/A format ensures long term compatability of your
file across computer systems.

Why not simply save it as PDF/A from Word?

Saving directly to a PDF/A version from MS Word often results in some text rotations, transparency, and
other placement and special effects to be lost in the PDF/A file. In short, the layout of the PDF/A that
Microsoft Word generates will can look very different from the way you laid it out.

Simple Conversion
Using an free online conversion tool is often the easiest way to convert a PDF to a PDF/A.

docupub.com/pdfconvert

The Docupub website has a tool that will allow you to convert your PDF to a PDF/A and retain all the
layout features of your Cover Sheet.

1. Output Format: Select PDFIA —————— ”

2. The form will change to:

1. Conversion Settings

Dutput format
POFIA v

3. Choose File: select the Cover Sheet you saved as a
PDF from Word on your computer. = -

2. Select the File to convert

H . . . Choose Flie  No e chosen
4. Select Wait for conversion in browser (normally this DO0RE 798 10 e chogen

Upload limit: 20M3 per file

takes just a minute or two). '
\ 3. Delivery Method
5. \:‘aﬂ for conversion in beowser *

Click Upload & Convert

(continued on next page)
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https://docupub.com/pdfconvert/

6. Download and Save the resulting PDF/A
file

DOk 30 vHEW £ 9 Y00 web Beowar

wr right click ca the lnk am:

30 dwoctly ol oad the e 00t yoor hand Sriee

a. Click the link with the file name \

J My_Cover_Sheet.pdf i #

b. The file might open in your
browser window. If so, click the download option to save it to your computer.

My_Cover_Sheet.pdf

Great
Expectations

SU0ljejOadX] 18319
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